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Other Sessions of Interest

- WP

T-4. Develop Better J2EE Applications with the Web Tools Platform (Wed 8:45)

— 101. Quick Tour of the Eclipse Web Tools Platform (Thu 8:30)

— 107. Leveraging JSF Components (Thu 8:30)

— 201. How to Build Java Web Applications with the Web Tools Platform (Thu 10:30)

— 301. Facing JavaServer Faces Development with JSF Tools (Thu 1:15)

— 401. Consuming and Producing Web Services with Web Tools (Thu 3:15)

— 501. Developing Java Web Services with the Web Tools Platform (Fri 8:45)

— 504. Developing Rich Applications with JSF and AJAX (Fri 8:45)

— 701. Building Applications with the Java Persistence APl and Dali (Fri 1:45)

— 706. Step by Step: Making Enterprise JavaBeans with J2EE Standard Tools (Fri 1:45)
801. How to Use and Extend Eclipse’s XML and Schema Tools (Fri 3:45)

- Other

T-6. Implementing SOA in Eclipse (Wed 8:45)
— T-7. Callisto Boot Camp: Ten Projects. One Day (Wed 8:45)
— 106. How to Improve Database Connectivity with the Data Tools Platform (Thu 8:30)
— 107. Leveraging JSF Components (Thu 8:30)
— 202. Web 2.0 the Eclipse Way with the Rich AJAX Platform (Thu 10:30)
— 204. Interacting with Relational Databases (Thu 10:30)
— 406. Developing and Deploying Services using the SOA Tools Platform (Thu 406)

— 607. Advanced User Interface Programming Using the Eclipse Rich Client Platform
(Fri 10:45)
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e WTP Overview
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Web Tools Platform Project (WTP)

e Top Level Eclipse Project
e www.eclipse.com/webtools/
e Included in Callisto release
e Development tools for web and JEE development
— No runtime dependencies
— Vendor extensible
e Subprojects
— Web Standard Tools (WST)
— J2EE Standard Tools (JST)
— JavaServer Faces Tools (JSF)
e Current version 1.5
e Dependencies
— Eclipse 3. 2
— Eclipse Modeling Framework (EMF) 2.2.0
— Graphic Editor Framework (GEF) 3.2
— Java EMF Model (JEM) 1.2

Judd Solutions




WTP Subprojects

e Web Standard Tools (WST)

— Web artifacts
— Defined by open standards bodies

e J2EE Standard Tools (JST)

— J2EE components
— Java Community Process (JCP)
— Depends on WST

« JavaServer Faces Tools (JSF)
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WTP Scope
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WTP Web Services Scope

e World Wide Web Consortium (W3C)

— http://www.w3.0rqg
— HTML, XHTML, CSS, XML, XSLT, XML Schema, XML Query

< Organizations for Advancement of Structured
Information Standards (OASIS)

— http://www.oasis-open.orq
— e-Business standards for web services

e \Web Services Interoperability Organizations (WS-I)
— http.//www.ws-i.0rg
— Interoperable message exchange between web services
e Java Community Process (JCP)
— http://www.|cp.org
— Java Web Services APIs
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WTP Installation Options

e Callisto
e All-in-one
— Eclipse 3.2
— Eclipse Modeling Framework (EMF) 2.2.0

— Graphic Editor Framework (GEF) 3.2
— Java EMF Model (JEM) 1.2

e Update Manager
— Eclipse.org update site

e Plecemeal

* JSF Is a separate install
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e \Web Services Overview
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Simple Object Access Protocol

From the draft W3C specification:

SOAP is a lightweight protocol for exchange of
iInformation in a decentralized, distributed
environment. Itis an XML based protocol that
consists of three parts: an envelope that defines a
framework for describing what is in a message and
how to process it, a set of encoding rules for
expressing instances of application-defined
datatypes, and a convention for representing
remote procedure calls and responses.

http://www.w3.0rq/TR/soap/
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e Web Service Definition Language

e Describes
— What the service can do
— Where it resides
— How to invoke it

e Elements
— Types - data type definition
— Message — definition of data being communicated
— Port Type — abstract set of operations
— Binding — concrete protocol and data format
— Service - collection of related endpoints
— Port - binding and a network address
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Apache Axis

e Apache Web Services Project
e Open Source

e SOAP implementation

« Version 1.3.0

e http.//ws.apache.org/axis/
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e Consuming
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Weather Forecast Web Service

Zip code: |43085 Submit Query |
= Forecasting weather by zip code  sueames wormncrox

State Code: OH

_ 7 day forecast Area Code: 614

Time Zone: EST
Latitude: 40.105156

— Place name Longitude: 83.01007
Allocation Factor: 0.00251
— State Code FIPS Code: 39

7 Day Weather Forcast:

— Latitude and Longitude
Saturday, July 22, 2006 ' SOTSTE
e Found at X Methods 27°C/14°C

(www.xmethods.net) s 0y 25,2006 Rl T
- Sel‘Vice deSCI‘iption Monday, July 24, 2006 ! !,. ﬁii‘;i
- www.webservicex.net/WeatherForec |, . [ oo
e 31°CR0°C

ast.asmx L
r" 85°F/68°F

Wednesday. July 26, 2006 [ L 29°C0°C
S 29°C/2

85°F/68°F
Thursday, Julv 27, 2006 ?‘ 29°C/20°C
30%
, 85°F/68°F
Friday, July 28, 2006 m 20°C20°C
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Weather Forecast Web Service

Service description

<2 WeatherForecast E © WeatherForecastSoap
= WeatherForecastSoap ## GetWeatherByZipCode
hittp:/ /v webser... 1 Input parameters | [e] GetWeatherByZipCode
N output parameters | [&] GetWeatherByZipCodeResponse
& GetWeatherByPlaceName
1 Input parameters | [&] GetWeatherByPlaceName
< output parameters | [ GetWeatherByPlaceNameResponse

Data transfer objects

|/ WeatherForecasts [E] ArrayOfWweatherData [£] WeatherData

[¢] Latitude [1..1] float = —[e] WeatherData [0..*] WeatherData (¢] Day [0..1] string
[e] Longitude [1..1] float (e] WeatherImage [0..1] string
[e] AllocationFactor [1..1] fioat (el MaxTemperatureF [0..1] string
[e] FipsCode [0..1] string “ | [@ MinTemperatureF  [0..1] string
le] PlaceName [0..1] string (e] MaxTemperatureC [0..1] string
[e] StateCode [0..1] string [e] MinTemperatureC [0..1] string
[e] status [0..1] string

[e] Details [0..1] ArrayOfweatherData
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Consuming Web Services Strategy

A common anti-pattern is to generate the
web service client stub code directly into an
application. Instead generate the code In its

own project, export it as a jJar and manage it
as a jar.

e Less files to maintain
e Improves reuse of client code

e Generated code does not follow code
guality standards
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Consuming Web Services Steps

1.
2.
3.
4.

Judd Solutions

Create Java Project

Download WSDL

Generate Web Service Client from WSDL
Export client Jar



Create Project

e Create a standard
Java Project

« File > New > Project >
Java Project

Judd Solutions

& New Java Project

Create a Java project

Create a Java project in the workspace or in an external location.

x|

—

Project name: Iweatherfnrecast-ws-client

-Contents
% Create new project in workspace

" Create project from existing source

Direchors | Er\workspaces\eclipseworid\weatherforecast

-JRE

@ Use default JRE (Currently 'jre1.5.0_06")

" Use a project specific JRE:

Configure JRES...

-Project layout
% Use project folder as root for sources and class files

" Create separate source and output folders

Configure default...

(7 < Back | Mext =

| Finish I

Cancel




Download WSDL

e Download WSDL
e Add WSDL to project
e Include it In the exported Jar file

e Provides traceability incase there is a need
to know which WSDL version was used to
generate stubs and Jar
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Generate Web Service Client

e Right click on WSDL and choose Web Services >
Generate Client
or

Flle > New > Web Services > Web Service Client

: x
e Specify Java Proxy e

Review your Web service options and make any necessary changes before proceedingto 3

= Monitor traffic using

Service definition: | fweatherforecast-ws-client/WeatherForecast.asmx.wsdl Browse... |
Client type: |Java Proxy j
Develop client Configuration:
Server:
Web service runtime: Apache Axis
g = Client project: weatherforecast-ws-client
m = e

[~ Monitor the Web service

[~ Do not show me this dialog box again.

= Back | Next = | Finish I Cancel |

Judd Solutions




Generate Web Service Client

e Specify project to generate the code in

x

Web Service ProxyPage ==

Select generate proxy if you want to generate proxy for your i 3
service.

[v | Gemerate proxy

Output folder |,fweath erforecast-ws-client j

[+ Define custom mapping for namespace to package.

(7) < Back Next = Finish Cancel
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Generate Web Service Client

e Optionally, can specify namespace to package
mapping
e Convert targetNamespace to a more

conventional Java package naming convention.
x|

Web Service Client Namespace to Package Mapping ~+
Define custom mapping for namespace to package. / 3_

Mapping pairs

package |
net.webservicex.weather

Imp-ort...l Add |Remove|

(7) < Back | et = | Finish Cancel |
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e Classes

— Service interface miermw =0

— Dynamic proxy service impl B & ©

. : =
B StUb_ service lmpl = 1= weatherforecast-ws-client
— Service locator impl ---!u WeatherData.java
— Data transfer objects - B-U] WeatherForecast.java

-4J] WeatherForecastLocator.java

= Axis Jars ---!u WeatherForecasts.java
— axis.jar & [J] WeatherForecastSoap.java
— jaxrpc.jar ---|1| WeatherForecastSoapProxy.java
. H-1 y
— saajjar )| WeatherForecastSoapStub.java

- X WeatherForecast.asmx.wsdl

— wsdl4j-1.5.1.jar
— commons-discovery-0.2.jar
— commons-logging-1.0.4.jar

* \When using the client Jar, these Axis jars will be required as well. -
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Using Generate Classes

WeatherForecastLocator forcastLocator = new WeatherForecastLocator();
WeatherForecastSoap wfSoap = forcastLocator.getWeatherForecastSoap();
WeatherForecasts forecasts = wfSoap.getWeatherByZipCode(zipCode);
WeatherData[] details = forecasts.getDetails();

System.out.printin(forecasts.getLatitude());
System.out.printin(forecasts.getLongitude());

for (inti = 0; i < details.length; i++) {
WeatherData detail = details]i];
System.out.printin(detail.getDay());
System.out.printin(detail.getWeatherlmage());
System.out.printin(detail.getMaxTemperatureF());
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Export client Jar

JAR File Specification

Define which resources should be exported into the JAR. 1

Select the resources to export:

[7] . weatherforecast-ws-client [ 1 .classpath
1 [ .project
) readme.txt
¥ WeatherForecast.asmx.wsdl

[v Export generated class fies and resources

[~ Export all output folders for checked projects

[~ Export java source fies and resources

[~ Export refactorings for checked projects. Select refactorings

Select the export destination:
il Ri = \temp‘\weatherforecast-ws-client-1.0.jar Browse... |

Options:

[v Compress the contents of the JAR fie
[~ Add directory entries

[T Overwrite existing files without warning

(7} < Back | Mext = | Finish I Cancel |
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e Producing Web Services (bottom up)
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Producing Web Services

e Bottom up
— Java code -> Generate WSDL

e Top down
— WSDL -> Generate Java code

Judd Solutions



Bottom Up Steps

1. Create Dynamic Web Project
2. Create Service and DTOs
3. Generate Web Service
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Create Dynamic Web Project

e File > New > Other > Web > Dynamic Web Project
e Project Name x|

Dynamic Web Project

{ Targ et Se rver Create a standalone Dynamic Web project or add it to a new or existing @

Enterprise Application.

Project name: | order-ws-server

~ Project contents:
[v Use default

B =" )l | E:\workspaces\edipseworld\order-ws-server Browse, .,

-~ Target Runtime
|Apache Tomcat v5.5 L‘ Mew... |

-Configurations

<custom:= B

Hint: Get started quickly by selecting one of the pre-defined project configurations.

~EAR Membership
[T Add project to an EAR

EAR Project larme; | order-ws-serverEAR = e |

(7 < Back | Mext = I Finish I Cancel I
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Create Dynamic Web Project

e Facets and versions

& New Dynamic Web Project N _XJ
Project Facets >
Adds support for writing applications using Java programming ' \/
language.

Configurations: |Gtk Save | [helete |

Project Facet Version

~[v¥]i& Dynamic Web Module 2.4...

~[¥]4 Java Sl .

] =i 1avaserver Faces | 7%

~-[] Bl WebDoclet (XDoclet) [ N T

<< Show Runtimes

(7) < Back | Mext = | Finish Cancel |

Judd Solutions



Create Dynamic Web Project

e Context Root

e Directories
x|

Web Module y @
Configure web module settings. |,-_’ f’)
Context Root:

| order-ws-server|
Content Directory:
| WebContent

Java Source Directory:

| src

(?) < Back | et = | Finish Cancel |
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Create Service

public class OrderService {
private static final float DISCOUNT = 0.9f;

public float quote(float price, int quantity) {
If (quantity > 100) {
price = price * DISCOUNT;
}

return price * quantity;
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Generate Web Service

:
- New > File > Other > Web —

Web Services

SerV| CeS > We b SerV| Ce Review your Web service options and make any necessary changes before

proceeding to the next page.

ey,

Or . Web service type: iEvottom up Java bean Wweb Service

ng ht Cl | Ck O n ClaSS We b Service implementation: I com.juddsolutions.ws.OrderService Browse...

Services > Create Web "  Confguraton:

. _ & L3 Server: JBoss v4.0
SerVICeS de] (¥} Web service runtime: Apache Axis
4 = Service project: order-ws-server

- Select the amount to be f - (B [

g ene rate d Client type: |Java Proxy LI
< Monitor using TCP/IP T o P

Monitor

" ot L]

[~ Bublish the Web service
[~ Monitor the Web service

[ Do not show me this dialog box again.

Einish | Cancel I
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Generate Web Service

e Select methods to expose
e Select type x

Web Service Java Bean Identity q
— R P C Configure the Java bean as a Web service. é
* P e rfo rmance WSDL file: | OrderService.wsd|
i ~Methods
= Simple types "l cuoreoetnD

— Document
- InterOperabi”ty Select All| Deselect Al
e XML rStyle and use

¢ document/iteral (wrapped)
" document/iiteral

[ Define custom mapping for package to namespace.

@ < Back | Mext = | Finish I Cancel |
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Generate Web Service

e Start server to local application service

& web Service _><J
Start Server @
Start the server from this page. E : P

In order to proceed the server "Apache Tomcat v5.5" must be started.
Once the server is started the "next" button wil be enabled.

The "back” button can be used while the server is starting to

change any previous settings in this wizard.

Currently the server is stopped. Start server

(7) < Back Mest = Firish Cancel
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e Test Client

# web Service

Web Service Test Page
Select a test facility

Test faciity |Web Services Explorer

< Back Finish

Cancel

VWeb Services Explorer

! OrderServiceService
=-® OrderServiceSoapBindi

== Navigator 1+#| Actions
& WSDL Main .
: ' @
£ 2 file: /E: fworkspaces/ecipsew Invoke a WSDL Operation Source

Enter the parameters of this WSDL operation and click Go to invoke.
- Endpoints—

| http://localhost:8080/order-ws-server/services/OrderService Ll

price fioat
10.00
quantity int
10000

_Go | Reset|

i Status

‘ o

Source
quoteReturn (float): 90000.0
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Generate Web Service

= Publish web service to UDDI registry

& Web Service

Web Service Publication Q
Do you want to publish your Web service? i 5

[ Launch the Web Services Explorer to pubiish this Web service to the Unit Test UDDI Registry
[ Launch the Web Services Explorer to pubiish this Web service to a UDDI Registry
Public UDDI Registry [SAP UDDI Test Registry =]
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e \Web Service

— Axis deployment
descriptors

— WSDL
e Test Client
— Dynamic web app

— Proxy
— JSPs

=52 Order
B src

|§|---EB com.juddsolutions.service
"'Iil Order.java
=4 JRE System Library [JDK 1.5.0_06]
=i Tomcat v5.0 runtime
=i Web App Libraries
(= build
WebContent
+-(= META-INF
-G WEB-INF
= lb
E-= OrderService
=-E> com
=N juddsolutions
B-E= service
deploy.wsdd
deploy.wsdd.bak
undeploy.wsdd
----- server-config.wsdd
----- ¥ web.oeml
El-= wsdl
‘el Order.wsdl
=4 OrderClient
=g src
é---!’ﬂ com.juddsolutions.service
[J] Order.java
[J] OrderProxy.java
[f] OrderService.java
1J] OrderServiceLocator.java
1J] OrderSoapBindingStub.java

-2 Web App Libraries

[#-=4 Tomcat v5.0 runtime

-2 JRE System Library [JDK 1.5.0_06]
- build

-= WebContent

= META-INF

El-(= sampleOrderProxy

LB Inputjsp

=| Method.jsp

Result.jsp

[l TestClient.jsp

- WEB-INF

m
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Data Types

e Simple Java data types

e JavaBeans
— No parameter constructor

e Arrays
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e Testing
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TCP/IP Monitoring

« View SOAP request and response

Prnblems|Javadoc|Declaratinn|CnnsnIe|Snippets|Prnper‘ties|Sewersm & 5 | 7~ =04

=~ locahost:8209 Time of request: 5:22.10.996 AN

I /o derWS/services/Order Response Time: 831 ms
Type: HTTP
Request: localhost:8209 Byte - | Response: localhost:8080 Byte -
Size: 823 (1104) bytes Size: 463 (603) bytes

Header: POST forderWs/services/Order HTTP/1.0 Header: HTTPR/1.1 200 OK
<?xml wversion="1.0" encoding="UTF-8" 2> ~||<?xml version="1.0" encoding="utf-8" 2>~
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osoft Internet Explorer

a Web Services Explorer -

Fle Edit View Favorites Tools Help

(Jsack ~ ) ~ Iﬂ IELI ,J | /."’ Search “, Favorites @] Media 6“| - = = ool P m 3

Address Iiéj http://localhost:51246/wsexplorer/wsexplorer.jsp?org.eclipse.wst.ws.explorer=0 j | Web assistant &

Links |_| cintas | _/ groovy | _Jjava _/jst _Jtcms |_/ web @JDocs.com @Xanner @ Groovy Debugger XDoclet

GO"S‘”" j| [Clsearch = | @M= g [ popups okay | “¥ Check ¥ A Look for Map ¥ | ALtoril fd options &

Web Services Explorer

%5, Navigator | Actions
oEu WSDL Main @ . ) =
- 22 platform:/resource/ Ticket/GoogleS £2 Invoke a WSDL Operation 20urce
D_'f GoogleSearchService
B® GoogleSea.irchBlndmg. Enter the parameters of this WSDL operation and ciick Go to invoke.
&8 doSpelingSuggestion End L
&8 doGetCachedPage ndponts
i JdoGoogieSearch |http:ffapLgoog\e.comfsearchfbetaZLI
key string
OcMw4/RQFHIXS5I1w/c4Ww5fuiwbelL5a7
g string
Frlinse World hd
i Status
Source
= return
~ directoryCategories
= DirectoryCategory
fulViewableName (string): Top/Arts/Music/Concerts_and_Events/Festivals/World f
4| v |4 »

[ [ | [%Jrocalntranet

By

4
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Browser Testing

e |nvoke AXIs service via URL

&2 Morilla Firefox - 10| x|
File Edit View Go Bookmarks Tools Help
<::| X l_lL - %l | E-/D ! L1 :/flocalhost: 8080/order-ws-server/services/OrderService?method=quote&price=10&quanti ¢ L‘ @ Go |[(_3J|,

J cintas | groovy || Groovy Debugger |} maven | java | ) jst | tcms () web | | Wiki || XPlanner | | Seling to AAFES Home ... | | Thistle Class Association 3
_| http:/ /localh...0&quantity=10 | |
This XML file does not appear to have any stvle information associated with it. The document tree is shown below.

—<soapenv:Envelope>
—<soapenv:Body>
—<qguoteResponse soapenv:encodingStyle="hitp://schemas xmlsoap org/soap/encoding >
<guoteReturn href="#d0"/>
</guoteResponse>
<multiRef id="id0" soapenc:root="0" soapenv:encodingStyle="hitp://schemas xmlsoap.org/soap/encoding” xsi:type="xsdfloat">100.0</multiRef>
</soapenv:Body>
</soapenv:Envelope>
[

’E| Done
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WSDL Editor

e Graphically edit WSDL

@ Web Services Explorer

L4 OrderServiceService 1] & OrderService
= OrderService % quote
http://localhost:808... [ price [=] float
L1 Input
[r' quantity [=lint
@ output | 7 quoteReturn | [=l float

Design | Source|
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e Deployment
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Package

e File > Export > WAR file

M
WAR Export
Export Web project to the local file system. 1 @

Web module: I Order j

Destination: | SHGII S CERE S v| Browse... |

[~ Export source files
[T Overwrite existing file

< Back HeERk = Finish Cancel
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Deployment

e Container specific

e Admin console

e Deployment directory
e Ant task

e Server View
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e Conclusion
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WTP Resources

e www.eclipse.org/webtools/
e WWW.pProjst.com

e Tutorials

— http://www.eclipse.org/webtools/community/communityr
esources.html#tutorials

e Articles

— http://www.eclipse.org/webtools/community/communityr
esources.html#articles

— Build rich Internet applications - http://www-
128.iIbm.com/developerworks/edu/os-dw-0s-laszlo-i.html

e New Group
— news://news.eclipse.org/eclipse.webtools
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Contact Information

e http://www.juddsolutions.com
e cjudd@juddsolutions.com

e Blog

— http://blogs.apress.com/authors.php?author=Christopher%20Judd

e Pro Eclipse JST
— http://www.projst.com
— http://www.apress.com/book/bookDisplay.html?blD=447

e Enterprise Java Development on a Budget
— http://www.apress.com/book/bookDisplay.htm|?blD=197

Pro Enterprise

. Java Development
E[:|I[JSE JST on a Budget

Fliag-ins tor JZEE Desnzlopmeent
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Questions ?

Please fill out your evaluations.

Slides can be found at

http.//www.juddsolutions.com/ew2006/
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